This tutorial is divided into a number of sections, allowing you to review the basic functions first, then learn about more advanced features. The first section is entitled "The Five-Minute Schematic and Simulation" and will give you a taste of how quickly you can put together a circuit with full simulation. The later sections are divided by subject, so you can study in greater detail the features that are important for your application.

These tutorials are intended only to introduce you to LogicWorks features. For complete details on any subject, see the reference sections of this manual.

**Tutorial Manual Format**

In the following tutorial sections, text with an arrowhead:

- like this

provides step-by-step instructions for achieving a specific goal. Other text provides background and explanation of the actions being taken.

**The Five-Minute Schematic and Simulation**

In this section, we're going to show how quickly you can create and test a circuit using LogicWorks.
Starting LogicWorks

- Start the LogicWorks program by double-clicking on its icon.

Once the program has started, you will be looking at a screen like this.

The LogicWorks menu bar is a taskbar from which other tools and windows can be selected.

The larger ("Schematic" or "Design") window is your viewport onto the circuit diagram, which you will manipulate using the various drawing tools. The smaller "Timing" window will be used by the program to display a timing diagram of the signals in your circuit. Either of these windows can be moved or resized by the usual methods, to suit your needs.

Placing a Device

- Move to the Parts Palette and, using the drop-down list at the top of the palette, select the library "demo.lib."

Windows - The list of open libraries can be changed manually using the Parts pop-up menu's Open and Close commands, or any collection of libraries can be opened automatically at startup by modifying the LogicWorks initialization file.
The list of open libraries can be changed manually by either:

- pulling down the File menu on the Menu Bar and highlighting Libraries, then clicking right on a fly-out submenu containing New Lib, Open Lib, and so on, and selecting the appropriate command; or
- command-clicking on the Parts Palette, then selecting from a pop-up menu that contains the first five of the six options that are listed on the submenu.

Any collection of libraries can be opened automatically at startup by modifying the Setup file.

- Double-click on the device type "164" in the parts list and then move the cursor back into the circuit window. The cursor on the screen will now be replaced by a flickering image of the selected symbol, in this case an 8-bit shift register.

The numbered devices in this library are generic 7400-series types. The labeling and simulation characteristics can be adjusted to match the various 7400 families on the market.

- Position this image somewhere near the center of the circuit window and click the mouse button. A permanent image of the device will now stay-behind in that location and the flickering image will continue to follow your movements.

More devices of the same type could be created at this point, but in this example we wish to select another symbol.

- Press the spacebar to return to Point mode. Notice that you can click and drag the device that you placed to any desired new position.

- Move again to the Parts Palette and this time double-click on the XNOR-2 type. Once you move outside of the Parts Palette, the cursor will immediately change to match the new symbol.

The XNOR-2 and the devices in the primstage.cif, primilogi.cif, and primicio.cif libraries, are called "primitive" types because they have built-in simulation models in LogicWorks. Other devices, such as those in the 7400devs.cif library are called "subcircuit" types because their simulation models are made up of primitives. If LogicWorks is being used only for schematic entry, it is also possible to make symbols with no simulation function.
Chapter 4 - Tutorial

Place one of these Exclusive-NOR gates adjacent to the 164 device so that the pins just touch, and click once to anchor the device.

Press the spacebar to return to Point mode.

Whenever you place devices or signal lines so that they touch, you will notice that the signal lines flash briefly. This indicates that a logical connection has been made. You do not need to explicitly request a connection.

Moving a Device

Point at the Exclusive NOR gate and click and drag to the right. While you hold the mouse button you can drag the device to any desired new position. Note that any signal lines attached to the device are adjusted continuously to maintain connection.

Position the gate as shown to the right of the 164 device.

Drawing Signal Connections

Attach a connection to the output of the gate by positioning the pointer near the endpoint of the pin and dragging away to the upper left.

Notice that two lines at right angles will follow your mouse movements to connect the starting and ending points.

Windows—While moving the mouse, try pressing the [Ctrl] and/or [Shift] keys and note the different line-routing methods available. Click mouse once to anchor the signal line.

Macintosh—While moving the mouse, try pressing the [Option] and/or [Option] keys and note the different line-routing methods available.

For details on these line-routing modifier keys, see the section on Signal Line Editing in Chapter 5. Schematic Editing.

Leave a right angle line attached to the gate, as shown.
Chapter 4 - Tutorial

- Extend this line to connect to the B input of the 164 by clicking at the line endpoint where you left off, dragging the line to the B input, and releasing the mouse button.

- Add a connection to pin A by clicking at the end of the pin, dragging the line down until it touches the signal line, then releasing the mouse button.

Notice that an intersection dot appears automatically whenever three or more lines intersect.

- Try repositioning a line segment by clicking and dragging anywhere along the length of the segment except at a corner or intersection.

The Five-Minute Schematic and Simulation

Binary Switch Input Device

- Return to the Parts Palette and select a Binary Switch device from the demo.lib library.

- Place it as shown on the diagram.

- Press the spacebar to return to Point mode.

- Try clicking on the switch. Notice that it changes between the 0 and 1 states.

In order to move a switch, you must first select it by holding the [Shift] key while clicking on it. This is necessary because the switch has a special response to a normal mouse click.

The devices in the primio.lib library can be used to actively control and observe the simulation right on the schematic. Each of these devices responds immediately to changes in the simulation in progress. The Hex Keyboard device is similar to the switch except that it operates on four lines at once.
Clock Generator Device

- Select a Clock device from the demoSibcl library and place it on the diagram just below the switch.
- Press the spacebar to return to Point mode.
- Route wires from the switch and clock to the 164, as shown. Remember to try using the Ctrl and Shift keys on the Windows keyboard, or the Option and Command keys on the Macintosh keyboard, to route the wires.

While you have been working on the diagram, the LogicWorks simulator has been running continuously, simulating the effects of the new connections that are being made. So far, though, we have not asked it to display any results. This is done either by placing probes on the diagram or by displaying signals in the Timing window.

Naming a Signal

- Click on the text icon in the Tool Palette. The cursor will then change to a pencil shape, which will be used to select the item we want to name.
- The text cursor is used to name devices and signals, to apply pin numbers to device pins, and to add free text notations to the diagram.
- Position the tip of the pencil anywhere along the length of the line running from the clock device, and press and hold the mouse button. The cursor will change to an I-beam shape.
- Still holding the mouse button pressed, move the cursor down somewhere below the signal line.
- Release the mouse button. A blinking insertion marker will appear.
- Type the name "CLK" on the keyboard, then press the Enter key or click the mouse button once.
- Return to Point mode by clicking the arrow icons in the Tool Palette. Note that the name can be dragged to any desired position.
- Click once on the Binary Switch to change it to the logical 1 state.
Chapter 4— Tutorial

The Timing Window

You will immediately see the Timing window come to life with the displayed values on the CLK line. By default, any named signal is shown automatically in the Timing window.

Windows—Pull down the Timing menu and deselect the Add Automatically command.

Macintosh—Pull down the Simulate menu and deselect the Auto Add command.

For those using the text cursor, name the two data lines from the shift register and the output line from the gate, as shown. The simulated output from these lines will immediately appear in the Timing window.

Simulation Controls

- Select Simulator (Windows) or Sim (Macintosh) from the Tools menu to make the Simulator Palette visible.

Windows—Click on the < and > buttons and observe that they affect the time scale of the Timing window.

Macintosh—

- Click on the < and > buttons and observe that they affect the time scale of the Timing window.

Display resolution can be adjusted from 4 pixels/time unit to 100 time units/pixel. The interpretation of a “time unit” is arbitrary, but it is convenient to think of it as a nanosecond.

Windows—

- Select Display Off from the Timing menu in the Timing window. You will notice that the Timing window goes blank and the current time indicator in the Simulator Palette advances much more quickly.

- Select Display On from the Timing menu in the Timing window to re-enable the display.

- Click on the Reset button and then the Run button and notice that the simulation restarts at time 0.
Macintosh—

- Try clicking on the Disp Off button. You will notice that the Timing window goes black, and the current time indicator in the control palette advances much more quickly.
- Click again on the same button—which now reads “Disp On”—to re-enable the display.
- Click on the Restart button and notice that the simulation restarts at time 0.

Windows—Pull down the Speed menu in the Simulator Palette. Notice that the “Run” menu item is checked. Select the menu item immediately above ("Jog") and notice that simulation slows. Continue selecting higher menu items until the simulation stops.

- Click repeatedly on the Step button and observe that the simulation proceeds one step at a time.
- Select Run from the Speed menu in the Simulator Palette.

Macintosh—On the Simulator Control Palette, click on the arrow at the left end of the speed control bar. Notice that each click slows the simulation by one step. Continue clicking until the simulation stops.

- Click on the Step button and observe that the simulation proceeds one step at a time.

The Step button advances the simulation to the next time at which there is some circuit activity, not necessarily just one time unit. The size of the step will depend upon the circuit.

Probe Device

- Select the Binary Probe type from the Parts Palette.
- Place a probe so that its pin contacts a signal line to view the simulation value on that line.

As the simulation progresses, the values on all probes are updated immediately. A similar device, the Hex Display, is also available to show groups of lines in hexadecimal. These simulation devices can be flagged to indicate that they are not a real part of the finished product and should not be included in any netlists or bills of materials.

**Setting Device Parameters**

- Click in the window, but away from any circuit objects. This deselects everything.
- Click on the XNOR gate to select it.

Windows—Select the Parameters command in the Schematic window’s Simulator menu.

Macintosh—Select the Simulation Params command in the Simulator menu.

- Click on the “+” button a couple of times to increase the propagation delay in this device.
Saving the Design

Windows—Select the Save Design As command from the Schematic window’s File menu, and save your circuit so you can continue with it later.

Macintosh—Select the Save Design As command in the File menu and save your circuit so you can continue with it later.

This ends the Five-Minute Schematic and Simulation tutorial section.
Chapter 4 - Tutorial

c Editing

The object of this tutorial is to take a closer look at LogicWorks' schematic editing features. We will do this by making a number of modifications to the circuit file created in the Five-Minute Schematic and Simulation demonstration.

Topics covered in this section:
- Deleting and moving objects
- Selecting device types by name
- Device symbol rotation
- Using power and ground connectors
- Connecting signals by name
- Using Copy and Paste on circuit objects
- Naming devices
- Adding pin numbers to devices
- Placing text notations on the diagram.

Opening a Circuit File

- Open the file you created in the initial demonstration, using the Open Design command on the File menu.

File
New Design
Open Design...

The file created in the first section is also supplied with LogicWorks in the demos directory/folder.

Schematic Editing

Deleting Objects

- If the Tool Palette is not visible, click once in the circuit window.
- Select the Zap (lightning bolt) tool in the Tool Palette. The cursor will change to match this icon.

This tool is used to remove a single object from the diagram. When aimed at a device, the device is removed. When aimed at a signal line, the line segment is removed to the nearest device pin or intersection.

Zap Tool

Breaking a Signal Line

- Zap the segment shown.